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A Settlement Agreement
was reached in mediation
on February 24, 2009 in
the case # CV 160915 filed
in the County of Santa
Cruz as Earl Heal v. Cali‐
fornia Grand Jurors’ Asso‐
ciation & Judith Lazenby
And Cross Action. Items
within the agreement to
be noted are:
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Journal

President’s Message
By Tony Noce

Once again it is indeed a pleasure to report to the membership. Your officers, directors,
committee chairs and members have been very active in fulfilling
their accepted responsibilities to the membership.

Honorary CGJA member Arnold Schwarzenegger, Governor of the
State
of California, did proclaim February 2009 as “California
1. CGJA acknowledges
Grand Jury Awareness Month” thus so supporting and acknowl‐
that it made errors dur‐
edging, “The hard work done by our grand juries has a great im‐
ing July 2007 regarding
pact throughout our communities and have helped to make Cali‐
the requests for corpo‐
fornia a better place. These accomplishments can only be made
ration assets related to
through the outstanding dedication of those who volunteer to
providing information to
become grand jurors, and I thank them for their fantastic efforts.”
the membership on a
ballot measure.
Public Awareness ceremonies were held and proclamations were issued in counties and
cities throughout the state from San Diego to Shasta in an effort to support and encourage
2. Former director Earl
grand juror recruiting.
Heal, (Heal) acknowl‐
edges that his handout
In February the board met in Sacramento for a Retreat meeting. A retreat meeting is differ‐
of the Ad Hoc Bylaws
ent from a regular board meeting in that no official business is conducted. The chance to
Review Committee and meet face to face results in a much easier and freer exchange of ideas. Operating in an en‐
vironment free of parliamentary procedures is more conductive to productive discussion.
its distribution during
the annual conference
Following the morning retreat meeting the board held its regular February meeting in the
in October 2007 was
afternoon. The agenda and minutes can be reviewed by the membership by going to the
performed by Mr. Heal
CGJA website home page and clicking on “Board Information”. A summary of these actions
on the mistaken as‐
may be found elsewhere in this issue. Attendance (88%) at the meetings was financed by
sumption that the hand‐
board members’ personal expense. No association funds were used. A teleconference
out had inadvertently
phone line was available for those who could not attend the meeting in person. As presi‐
been omitted from the
dent I want to acknowledge the board and committee chairs who attended for their dedi‐
Annual Conference
cation, sacrifices and willingness in their show of support of the CGJA.
handbook, when, in
The CGJA leadership is presently actively involved in updating our membership records in
fact, the Board did not
anticipation of membership renewals. Please let us know if your contact information is in‐
intend to publish Ad
Hoc Committee reports. correct or if you did not receive any recent past Journals.

3. All parties will execute a
release and dismissal
with prejudice of his/
her/its action without
admitting to any legal
liability.

We are in the process of seeking Excellence in Reporting award candidates as stated in your
previous Journal issue. We are presently seeking candidates for Directors, as stated else‐
where in this issue of the Journal. In February the 2009 Annual Conference committee had
a productive meeting with the new Sacramento Chapter. We are also in the process of ac‐
cepting county applications to host the 2010 CGJA Annual Conference. The Training com‐
mittee also met in Sacramento for a two‐day “Train the Trainers” session in preparation for
their 2009 training seminars to be held throughout the state this summer.
continued on page 2
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Presidents’ Message continued from page 1

The following are a few suggestions that
you as members can do to help us in our
efforts to ensure we meet our mission and
purpose.

a. Renew your membership. Financial
support is critical. You must be a mem‐
ber in good standing by July 31, 2009,
to receive a ballot to vote.
A native Californian,
Karin received her
B.A. at the University
of California, Berkeley and J.D. at the
University of Davis.
She has practiced as
the General Counsel/Senior Vice President for several
healthcare companies in the United
States, Europe, and
the Middle East for
30 years.

b. Consider a monetary donation to the

2009 Annual Conference

CGJA.

c. Volunteer your time and talents to one

e. Seek out friends or business associates

We are pleased to announce the
dates for the 2009 CGJA Annual
Conference are October 29th and
30th. The location is the
Doubletree Inn,, 2001 Point West
Way, Sacramento (near the
California State Fairgrounds)

to join the CGJA as an Associate Mem‐
ber. This is a good way to “educate the
public”.

The room rate is $84.00 per night,
single or double occupancy

of our many CGJA functions.

d. Consider running for a Director position
this coming election or recommend
someone who you feel will be an asset
to the CGJA.

f. Share your thoughts by contributing a
“Letter to the Editor” in the Journal.

Registration fee has not been
established but should be similar
to previous years (about $60.00)

As Foreperson of the
2006-2007 Marin
County Grand Jury,
and a holdover on the
2007-08 jury, she
served as an investigative committee
Chair, lead author,
contributing author
and editor, and is active in legal and continuity issues. Karin
has served on the
CGJA Special Investing Subcommittee.

g.

Karin brings an abundance of energy and
intense commitment
to the principles of
the grand jury and a
focus on enhancing
effectiveness and
membership through
direct, concise, consistent communication.

The election season is almost here. Consider running for Director and joining the CGJA Board to
do the important work of the organization. Discuss and vote on compelling issues affecting the
membership. Board members are responsible for the direction of the organization.

Visit your CGJA website often to be‐
come better informed as to what is
happening in the CGJA. It is your infor‐
mational resource tool. Use it.

Submit a “Final Report” that “made a differ‐
ence” to the CGJA as a candidate for a Ex‐
cellence in Reporting award or a Grand Jury
Achievement report.
All of us working together can make our
dreams become reality.

Please watch our website for
further details and registration
information
We are planning a program that
will take advantage of the proximity of state government
officials

2009 Nominations-Elections Committee By Karin J. Hern, Chair
Calling all potential candidates for CGJA Director!

Directors’ responsibilities are covered in the CGJA Bylaws, Article 6, Section 4: “Duties”. In ad‐
dition, it is expected that Directors are active on at least one of the four standing committees
and will attend regularly scheduled monthly Board meetings (by teleconference). Proficiency
with some form of electronic communication, preferably email, is desirable. Directors have an
obligation to avoid personal agendas in order to serve the best interests of the organization.
Continued on page 3
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Continued from page 2

Two (2) Directors will be elected
from each of three (3) regions
(North, Central and South) for a total
of six (6) Directors. The two‐year
term begins at the Annual Confer‐
ence in late October, 2009. Cur‐
rently, several incumbents have indi‐
cated their intent to seek reelection:
in the North region, Sherry Chesny
and Ray Hoffman; in the Central re‐
gion, Judi Lazenby and Catherine
McKown; and in the South region,
Dianne Hoffman, Tony Noce and
John Sitton.
Important dates:
June 1: Due date for applicants to
notify the Nominations‐Elections
Committee of their interest in seek‐
ing election.
July 1: Due date for Intent to Run
statement (send to Nominations‐
Elections Committee at:
nominations@cgja.org).
July 31: Candidate must be a mem‐
ber in good standing as of this date.
July 31: Due date for candidate’s
statement (up to 200 words).
The members of the committee are:
North
Marsha Caranci and Keith North
Central
Owen Haxton and Karin Hern
South
Mary Johnston and John Mainland
Interested CGJA members, please
contact the committee at nomina‐
tions@cgja.org with your name, re‐
gion and county of residence. As a
follow up, you will be contacted by a
committee member and more de‐
tailed information will be provided.
Or you may contact any member of
the committee, or mail your infor‐
mation to Karin Hern, Chair, Nomi‐
nations‐Election Committee, 2338
Mar East Street, Tiburon, CA 94920

CGJA Chapter News
San Mateo County Chapter
By Joann Landi

At its March 16, 2009 meeting, the
Chapter awarded its second annual
$300 scholarship to Miss Brenda
Day, a Senior at Hillsdale High
School. Miss Day’s essay entitled
Protecting You From Injustice,
based on the Chapter’s website,
was chosen from many submitted
to the Hillsdale Scholarship Com‐
mittee headed by Ms. Sue Merport.
In addition to Chapter members
and Ms. Merport, Brenda’s proud
parents attended the meeting to
witness the presentation.

Winning Essay
Protecting You from Injustice

By Brenda Day, Senior,
Hillsdale High School, San Mateo County

When visiting the San Mateo
County Association of Grand Jurors
website there is an abundance of
information available to the public
on the Grand Jury. The website
presents an overview of informa‐
tion but also offers links to differ‐
ent websites to get a better under‐
standing of the Grand Jury.
The great aspect of the website is
that it offers a wide variety of infor‐
mation on the Grand Jury. There is
a link for middle school unit of
study that relates the student body
council jobs to the jobs of the
County Civil Grand Jury. The site
offers great insight and interesting
facts, like the jury is composed of
19 grand jurors who are mostly vol‐
unteers. Every year there are
about 1,102 grand jurors that serve
in the system to help citizens with
local government and school dis‐
trict misconduct. The website is an
educational learning because it of‐
fers information on other court sys‐
tems, such as Criminal Grand Juries,
Civil Grand Juries, Federal Grand

Juries, and Petit Courts. The San
Mateo County Association of Grand
Jurors website offers a look into the
qualifications of becoming a juror,
the importance of becoming a juror
and plenty of other material on the
SMCAGJ. The San Mateo County
Association of Grand Jurors website
was an educational benefit because
it showed there are people out
there willing to give up their days to
listen to citizens and help their
county improve.

BIRTH OF A CHAPTER
By Marian Mosley, President, Fresno
County Chapter

Ed. Note: This is another of a series of
reports featuring one of our chapters.
Congratulations to the Fresno Chapter
for “making a difference.”

Our labor began with an organizing
group in 2006. The chapter was
born on July 1, 2006 with a board of
seven members. Joan Gray was the
president. The first year we learned
to walk by recruiting members and
holding meetings.
We are now a robust two‐year old.
We have 50 members, led by a very
active nine‐member board. Each
board member chairs at least one
committee.
Program: We have three member‐
ship meetings each year. The atten‐
dance has been growing. In Febru‐
ary, there were over 50, our goal is
100. Our annual luncheon is held in
June.
Membership: Letters of invitation to
join were sent to the jurors from the
previous five years. The results
were good, but 2010 will be the Year
of Membership. This Year of Public‐
ity was partly designed to convince
jurors that we are a hearty organiza‐
tion.
Publicity: The Grand Jury in Fresno
has been a “secret society”. The
general public had many misconcep‐
Continued page 4
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tions and was unaware of the proc‐
ess of application. Things have
changed!! The media blitz began in
December, exploded in January and
February with the Board of Supervi‐
sors and the City Council issuing
proclamations announcing February
as “GRAND JURY AWARENESS
MONTH”. Governor Schwarzenegger
also sent a proclamation.
A one‐page flyer was sent to local
community organizations. A news
release and feature story was sent
to 14 county weeklies. Three ran op
‐ed articles. The Fresno Bee did an
in‐depth story, an editorial and let‐
ters to the Editor.
From December 20th to January
24th, Headline News on cable ran
five‐minute comments by a judge
and a former Foreman every ½ hour
during the day. Public radio and
three other stations had ½ hour
presentations. Judge Oliver and
various members appeared on local
radio talk shows. Promotional no‐
tices were posted on the community
calendars of all local television and
appropriate radio stations.
The result – many phone calls and
inquiries for applications. Fresno is
now AWARE of the GJ!! In 2005,
twenty‐six (26) applications were
received. We didn’t even meet the
legal requirement of 30. This year,
to date, there have been 129 inquir‐
ies and 97 applications. Publicity
works!!!
Speakers Bureau: To date, six ap‐
pearances have been made at Ki‐
wanis and Rotary Clubs. Requests
are pouring in. This committee is
also working with Fresno State Uni‐
versity to set up an Osher program
featuring the Grand Jury.
Brochures: A three‐fold glossy bro‐
chure was produced and widely dis‐
tributed.
Finance: A grant proposal has been
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presented, requesting $10,000 for
an educational and professional
DVD describing the activities of the
GJ and the Association.
Report Responses Review: The
past three years of GJ responses
are being reviewed for the purpose
of pin‐pointing the areas in which
responses were in agreement with
the proposed recommendations.
The committee is making contact
with them to determine if in fact
they have accomplished these goals
and if not, why not. They are also
compiling a list of the successful
recommendations.
Archives: Our accomplishments are
being preserved in an archival book
which is available at our member‐
ship meetings and for research pur‐
poses.
We are alive and well and expect‐
ing growth in all areas. Our enthu‐
siasm is high and our goal is to
maintain our energy to promote
the purpose of the Grand Jury.

Announcements
Membership List
We have had some difficulty in
maintaining our membership list to
the extent that some of you may
not have received recent Journals.
If you have not received the Dec
2008 or Feb 2009 Journals, please
let us know. You have the option
of viewing these issues on our web‐
site or we will mail you a replace‐
ment copy.
We apologize for the inconven‐
ience, but letting us know will help.
And should you move, please let us
know so that future issues of the
Journal and other association mail
can find you without delay. For
example, this summer we will be
mailing you a ballot for election of
directors and we wouldn’t that to
not find you.

Board Actions
By Joann Landi

2/22/09
Meeting
Approved
change of
name
of
GRIP Work‐
group
to
the
Daye
Index to honor Les Daye, whose
devotion to this effort is one of
his legacies.
Approved including telephone
numbers in the Journal and on
the website for those Directors
who have agreed to be listed.
Granted President authority to
sign on behalf of the Corporation
when mediation results in an
agreement. If conditions stipu‐
lated in mediation are not
agreed to, President will con‐
vene a Special Board Meeting.
2/25/09 Meeting
Accepted the settlement agree‐
ment as negotiated and recom‐
mended by the Litigation Com‐
mittee.
3/24/09 Meeting
Approved
budget.

2009

proposed

Approved additional language to
Expense Reimbursement Policy.
Approved Settlement Agree‐
ment article to be published in
the Journal.
Make additions to Directors' Cal‐
endar of Critical Dates.
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Using Digital Projection for Editing Grand Jury Reports By Barbara Sommer, Yolo County Grand Juror, 2008-9
An editing committee of nineteen can be a nightmare. The beast lives in Grand Jury procedure. I don't know how gen‐
eral the procedure is, but Yolo County's guidelines require that

•

"Each grand jury member should read the report carefully and provide comments, corrections, or objections before
or during the general meeting review. At that session, the grand jury decides what action to take on the report."

"If changes are required, the editing committee makes the appropriate revisions. Unless the jury has agreed to accept
the report with agreed upon revisions, the report is then resubmitted to the grand jury for approval." (Yolo County
Grand Jurors' Manual, 2009)
In practice that translates to a session in which each of the 19 jurors may suggest modifications to the report. The
modifications range from discovering typos and conflicts over syntax to major revisions. In any case the report must be
approved by a super majority (CGJA training manual, Final Report Writing, pg. 8).
The editing committee's review, which in our case involves six members, can be difficult. Although in theory the entire
body could agree to abide by the committee's editing, that has not been the case. And rightly so. Despite our best ef‐
forts, there are inconsistencies and ambiguities noted by the larger body. A flawless report is the goal. Once in print,
our words are there to show the public whether we have spent the year doing quality work or sloppy research.
The guidelines suggest that each juror could submit corrections or revisions. These could then be incorporated into the
report by the editing committee, and final approval would easily follow. In fact this is not the case for several reasons.
One is that jurors may be remiss with regard to doing their homework. Secondly, the suggestions and revisions re‐
ceived from various people may be contradictory. Thus, there doesn't seem to be any substitute for the entire jury's
going over the report line by line.
We have discovered a way to facilitate the editing process at both the committee and full jury level. It requires a laptop
computer, projector, and a report in Microsoft Word.
To prepare for the editing session,

1. Using Microsoft Word, protect the document ‐‐ from the top menu, select Tools > Protect Document. A window
with a password option will appear ‐‐ no need to protect with a password.

2. Select the Tracked Changes radio button, and click OK.
3. Use the projector to project the document on to a screen or blank wall.
4. It is best to project the report in Normal View mode ‐‐ top menu, View > Normal). (The alternative, Page Layout, is
not as clear in showing the edits.)
Delete or add material in the usual way. All modifications will be shown in color and can be modified as much as de‐
sired. There are default colors for deletions and additions. These can be changed using Preferences (top menu Word >
Preferences > Track Changes).
When all the additions and revisions have been made to the jurors' satisfaction, the report is ready to be put in final
form.

1. Unprotect the document ‐‐ top menu, Tools > Unprotect Document.
2. Select Tools > Track Changes > Accept or Reject Changes. A window will appear
3. Assuming that your report is in its final form (at least for this stage) you can ignore the information on the menu
and simply click the Accept All button on the menu.
Another window will appear asking you if you want to accept the remaining changes without review. Click Yes.
You now have a clean version of the editing report. Save it and give it a modified name (so as not to confuse it later
with the original).
If you wish to do further editing, repeat the above process.
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Humility Always Trumps Hubris
Open Letter
to the Board of Directors
I first joined CGJA in 1997, not
wanting my love affair with the
grand jury to end with my term. I
was elected to the board in 2003.
At that time, there was a dispute
between a longtime, extremely
active member and the board,
which ultimately ended up in the
hands of lawyers and cost CGJA a
lot of money, as well as requiring
the board to admit errors.
Not too long afterward, another
longtime active member twice had
to resort to hiring a lawyer in order
to halt brewing disputes with the
board.
Now, CGJA’s board once again has
spent significant amounts of
money, time, and energy defend‐
ing itself against charges brought
by yet a third very active member,
resulting in its having, as part of a
settlement, to admit to lapses.
In all this time—and I’ve been on
the board throughout—I have
never seen any attempt by the offi‐
cers or directors to engage in intro‐
spection, any effort to determine
what they might be doing or not
doing to cause repeated actions
against them. There has instead
been a hunkering down and virtu‐
ally total denial of any need to ex‐
amine the attitudes and behaviors
that might be contributing to such
extreme recourse on the part of
colleagues who have felt ill‐treated
or even slandered.
In the real world, hardly ever is
one side of a conflict completely
right, the other completely blame‐
less; more often, it’s a case of
“might makes right.”
CGJA’s greatest accomplishment is
the training program for new ju‐
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By Serena Bardell, Director, San Francisco

rors, in which, presumably, in‐
structors help students under‐
stand the importance of putting
aside personal agendas or preju‐
dices, learning to listen with an
open mind to fellow jurors, and
investigating without bias and
with as objective an approach as
possible.
Both former board members and I
lobbied passionately for training
in “boardsmanship” but were re‐
peatedly told there was no money
in the budget (and, implicitly, no
need). It’s possible that relatively
small expenditure might have
saved many thousands.
Instead of putting aside all busi‐
ness and dealing with better un‐
derstanding directors’ points of
view and ideas for implementing
organizational goals, plus devel‐
oping better communication and
empathy among members, CGJA
Retreats are, in effect, simply pre‐
board meetings, out of which
agenda items arise.
Several defenders of the status
quo appeared to believe that cut‐
ting the number of directors by
half would “get rid of the
‘troublemakers’”; but unanimity
belongs in dictatorships, not de‐
mocracies! Enlightened leaders
always welcome criticism and di‐
vergent perspectives. No one per‐
son can think of everything or be
expert in every aspect of organ‐
izational operation.
It is past time for all directors to
engage in honest self‐examination
and to dedicate the necessary
time and money to developing
better skills to fulfill their respon‐
sibilities to CGJA’s members. A
trained professional is essential to
accomplishing this urgent need.

Editor’s Response
By Jerry Lewi, Journal Editor

As past president who presided over
some of the incidents described in
Bardell’s letter, I would like to point
out that there have been significant
improvements in Board operations
since those times. Meetings that took
over three hours with a great deal of
contentious discussion are a thing of
the past and we are now able to de‐
vote our energies to the real business
of the association. Minutes and
agendas of these meetings are now
posted on our website in a timely
fashion as well as our Journal. We
have increased the number of active
chapters, many of which are making
major contributions to promoting the
grand jury system throughout the
state.
I share President Tony Noce’s opti‐
mism that we are moving forward in
a most productive manner.

Announcements
Annual Financial Report
The date for notifying our
membership of our previous
year’s financial status is ap‐
proaching. Please watch our
website for this information
that will consist of a Financial
Report for 2008, comparing
actual results with our budget
and a balance sheet as of De‐
cember 31, 2008
Training Committee
The 2009 schedule of Re‐
gional Training Seminars is set
and may be found on our
website along with hotel in‐
formation. If you do not have
access to this, please contact
Training Committee Chair,
Lew Avera.
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CGJA Officers
President
Anthony W. Noce
2808 Houchin Road
Bakersfield, CA 93304
661-835-7591
cgjaguy@yahoo.com

Vice President
Catherine McKown
P.O. Box 764
Mill Valley, CA 94942
415-383-5262
cdmac1@aol.com

CGJA Directors
North
Marsha Caranci, Shasta
caranci@aol.com
Sherry Chesny, Placer
sherry.c@cebridge.net
Ray Hoffman, Nevada
nrhoffman@comcast.net
Diane Masini, Nevada
domasini@sbcglobal.net

Judi Lazenby, Santa Cruz
judilazenby@aol.com
Catherine McKown, Marin
cdmac1@aol.com

South
Dianne Hoffman, Orange
cgjamailbox@yahoo.com

Kathy Wylie, Mendocino
kathy@mcn.org

Walter D. Hofmann MD,
San Diego
wdh438@gmail.com

Central

Mary Johnston, Kings
grammiemj@comcast.net

Serena Bardell,
San Francisco
sbardell@aol.com

Jerry Lewi, Ventura
cgjaprguy@roadrunner.com

Karin Hern, Marin
Karin.hern@sbcglobal.net

Anthony Noce, Kern
cgjaguy@yahoo.com
John Sitton, San Benito
sitton_john@yahoo.com

Joann Landi San Mateo
Joannelandi@aol.com

Standing Committee Chairs
Legislative Affairs
Bob Geiss
949-472-9763
bobgeiss@cox.net

Public Relations
Jerry Lewi
805- 532-1321
cgjaprguy@roadrunner.com

Membership Relations
John Mainland
661-587-7622
jcmg@lightspeed.net

Training
Lew Avera Jr.
949-388-8910
lewavera@cox.net

Secretary
Joann Landi
178 South Palomar Drive
Redwood City, CA 94062
650-365-4184
joannelandi@aol.com

Treasurer (Interim)
John Mainland
8609 Beaver Drive
Bakersfield, CA 93312
661-587-7622
jcmg@lightspeed.net

CGJA Chapters
Fresno County Chapter
Marian Mosley, President
marianmosley@att.net
Website:fresno.cgja.org

Nevada County Chapter
Ray Hoffman, President
nrhoffman@comcast.net

Humboldt County Chapter
Keath North, President
Krn48@aol.com

Sacramento County Chapter
Joseph Maloney, President
joepm@pacbell.net

Kern County Chapter
Trudy Slater, President
tslater@bak.rr.com
Website: kern.cgja.org

San Benito County Chapter
John Sitton, President
sitton_john@yahoo.com

Kings County Chapter
Betty Hampton, President
bettyh@cvip.net
Los Angeles County Chapter
William Selditz, President
whseld@aol.com
Marin County Chapter
Catherine McKown, President
cdmac1@aol.com
Website: www.mgja.org
Monterey County Chapter
Ray Wuco, President
carmelwuco@redshift.com
Napa County Chapter
Daniel Mufson, Ph.D.
President;
dan@apotherx.com

San Francisco County
Chapter
Jack McNulty, President
jlmn413@hotmail.com
San Luis Obispo County
Chapter
Jim Ragan, President
jimragan@charter.net
San Mateo County Chapter
Mike Miller, President
okmiller@pacbell.net
Website:
www.co.sanmateo.ca.us/
smcagj/
Solano County Chapter
Wanda Kiger‐Tucker,
President
kigertucker@juno.com

Our website is a great informational resource for grand ju‐
ries to use. Our “links” and “local Grand Jury information”
pages will take you to websites that can assist in research
and information
Visit us at www.cgja.org
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The Mission
of the
California
Grand Jurors’
Association
is
To promote government
accountability by
improving the training
and
resources available to
California’s
58 regular grand juries
and
educating the public about
the substantial local
government oversight
and
reporting powers
these grand juries have

Address Service Requested

Format for submitting
letters and articles to the
Grand Jurors' Journal
Articles should be e-mailed to
Jerry Lewi, Editor
cgjaprguy@roadrunner.com
Articles submitted by e-mail should be
saved in Rich Text Format and transmitted as an attachment to the e-mail
message.
If e-mail is not available, articles
should be faxed to Jerry at 805-2417912
Letters to the editor are limited to 200
words. (One hundred words for
“Kudos” thank-you letters).
The Journal will highlight opinion articles written by readers, experts, and
issues advocates. They may be 500 to
600 words in length.
We are especially interested in articles
on Grand Jury issues or solutions to
improving public education of the
grand jury system in California.
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